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Computer Graphics Lab 1:
2-D Computer Sketching I

INTRODUCTION TO SOLIDWORKS

SolidWorks© is a parametric solid modeling package that is used to build solid computer
models. The designer starts with a 2-D sketch that at first is loosely defined. Dimensions and
other constraints are applied to the 2-D sketch to fully define its geometry. The sketch is turned
into a 3-D solid model using an extrusion or revolution. If the base part is not correct, the
designer can simply change the dimensions of the original sketch or definition of the base feature,
and then re-build the part with a click of the mouse. Once the base part is defined, new sketches
can be defined on planes around the base part, and they can then be extruded to form bosses and
cuts on the part. Also, special design features can be easily added to the part, such as fillets,
chamfers, and counter bores. This is called feature-based modeling and it is the latest approach to
3-D computer modeling. In this first computer graphics lab, you will concentrate on 2-D
computer sketching methods, and will extrude or revolve simple parts. Four different, short
exercises are provided.

SOLIDWORKS TOOLBARS SETUP

Your instructor will show you how to launch SolidWorks on your computer. When you first
launch SolidWorks the screen will appear as shown in Figure 1-1. Your first task is to set up
your SolidWorks screen layout to have a common appearance that will be referenced throughout
this workbook. To accomplish this, follow these instructions. Go to the View pull-down menu
on the top of screen, select Toolbars and activate the following toolbars:
Dimensions/Relations,
Features, Sketch,
Standard, Standard
Views, and View, as
shown in Figure 1-2.
This will arrange the
common toolbars around
your screen for easy
access during your
exercises. Note that, until
you activate a part, these
toolbars are all faint in
appearance, meaning you
cannot access them. As
you get familiar with the
screen and the commands, | -
you may choose to turn | [sswisameremnas E

off some of these toolbars Figure 1-1. The initial screen in SolidWorks
or turn others on.
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Figure 1-2. Setting the Proper
Screen Toolbars during Setup.

STARTING A NEW PART

To start your session with SolidWorks, you need to pull
down the File main menu and click on the New command.
This will invoke an on-screen menu, as shown in Figure 1-
3. You have three options: Part, Assembly, and Drawing.
To start a new model, click Part and then OK. Once you
have clicked the OK button, the screen changes into the
SolidWorks computer working space with all the previously
checked toolbars ready to be used. Your first step is to
study this initial screen layout as depicted in Figure 1-4.
Some of the toolbars may appear at other positions on the
screen.

New SolidWorks Document ‘z‘
Templates
= N El=
=
Assembly Drawing
Previgw
Preview is not available.

L QK J [ Cancel ] [ Help l
Figure 1-3. Starting a New Part in SolidWorks.

THE SOLIDWORKS
SCREEN LAYOUT

The SolidWorks screen layout
when you start a part uses the
top, left, and right side of the
screen to arrange various
menus and toolbars.  The
center of the screen is the
computer sketching area for

your design work.  Study
Figure 1-4 to become
familiar with this standard

screen layout. Each of these
menus and toolbars will be
described in the subsequent
paragraphs.
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Figure 1-4. The SolidWorks Screen Layout with Major
Menus and Toolbars Identified.
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MAIN MENU

File is where you can create New files and Open, Save, Print Preview, and Print existing files.
You also can set up your Page on this menu.

Edit is where you can Undo the last command, and Cut, Copy, and Paste Entities. It also has the
Rebuild command that you may find convenient when you make changes to your model.

View is where you Redraw and set Display parameters. You can set the View Orientation, and
select View commands like Zoom, Rotate, and Pan.

Insert is where the major feature creation commands are located. Here you can create the Base
part, Cut the part, and invoke many of the parametric features.

Tools has an assortment of helpful commands. It has Sketching Tools, Dimensioning Tools, and
Relations Tools. It also has analysis tools like Mass Properties.

Window is where you can set some window properties like vertical and horizontal tiling.

Help is where you can access on screen listings of the command functions and other information
that will help you navigate and learn SolidWorks.

»

5

FEATURE MANAGER TREE W Partt i
EB-- Annotations

SolidWorks has a special “Feature Manager Tree” capability that . §= Material <nat specified»

keeps track of the solid modeling process. It relates each feature | | - <32 Front Flane

with the appropriate sketch in a tree diagram and allows you to | | @

edit your feature later if needed. The “Feature Manager” will | | g BIghcpienE

appear after you have begun a new part or have opened an E E;Igﬁl:etchl

existing solid model. It is located in the upper left part of the

screen. Figure 1-5 shows an example of the Feature Manager. Figure 1-5. Feature
Manager Tree.

THE REBUILD BUTTON

The “Rebuild Button” is located on the Standard | = ©-9 Gl8E- :
Toolbar and looks like a red/green traffic light, as $ PAH @ﬁ‘l@ PID % |: O

shown in Figure 1-6. When you press it with the & | {r[ﬁe;wl:d ] - )
mouse button, it will rebuild your model and update | | *FarlEt SUENTRIE e pa seeRne o T
any changes that have been made. Figure 1-6. The Rebuild Button.
TOOLBARS

Toolbars are clickable icons along the top and side of the screen that permit quick and easy access
to some of the more common commands used in SolidWorks. You can see the toolbars, grouped
by function, in the general screen layout of Figure 1-4 on page 1-2.
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View and Standard View Toolbars are shown in Figure 1-7. The View Toolbar contains
buttons for several Zoom commands, the Rotate View command, and the Pan (Move) View
command. It also has icons to represent your model as a wireframe, with light gray hidden lines,
with hidden lines removed, as a shaded image, and as a shaded image with a shadow. The
Standard View Toolbar allows you to select Front, Back, Left, Right, Top, Bottom, Isometric,
and Normal Views.
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Figure 1-7. The View and Standard View Toolbars on the Top of the Screen

Sketch Toolbar is shown in Figure 1-8. It can be divided into sketch entities, relations, and
dimension tools. To start, you click on the Sketch icon. As you establish 2-D sketch entities,

you can use Dimension and Add Relation buttons to fix the —
geometric parameters of your design. To aid you in your Sketch Mode B8
sketching, numerous 2-D entity icons are available, such as Dimension (i
Line, Arc, Circle, and Rectangle. To edit your sketch, Line '\
several common commands like Trim, Mirror, Fillet, and R*’Ctgf‘gl'e g
. Ircie
Offset are available. Centerpoint Arc |8
T: A P
SKETCHING PLANES [ angentArc g
Before you start a 2-D sketch with SolidWorks, you must define SI(CE:E?elr:Iiilllfet o
(highlight) a sketch plane. The three default orthogonal sketch spline r\’
planes are the three Point BB
standard orthographic e ‘ AddRelation [
view planes: Front, _ Modify Relation |8
Top, and Right, as ’ ‘ Mimor |8
Later, you can also pick forrere L Offset |5
any plane or flat surface Trim  |8E
on a base part that has ~ Construction Geometry [
been created. The Move or Copy Entities E
surface does not 3-D Sketch 22
necessarily have to be . )
parallel to one of these Flgu?k;t(gl. P”ll“:;els)efault Flgur; 1'1?) Sketch
three principal planes. i oo™ bar.
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LINE COLORS

SolidWorks has several ways to feedback information to the user. One of these ways is to use
different line colors. When sketching 2-D profiles, the following color codes prevail.

Green lines mean that the entities are Selected.

Blue lines mean that the dimensions of the geometry are Under Defined.

Black lines mean that the dimensions of the geometry are Fully Defined.

Yellow lines mean that the dimensions of the geometry are Over Defined (undesirable).
Gray lines mean that these entities are not in the active sketch.

STANDARD TEMPLATES P

Before you start any exercises in
SolidWorks, it is a good idea to
establish some standard drawing
templates and title blocks to reflect the
two styles of engineering
measurements. One set will be for the
American National Standards Institute
(ANSI) for Inches and the other for

Metric.

To start, go to File, select New, then
Part and OK this selection. Go to the

Tools pull-down menu. Select Figure 1-10. Document Properties Menu.

Options. Under the Document
Properties tab, make sure that the | [eecERtElcEl
Dimensioning Standard is sect for
ANSI (see Figure 1-10). Next select
Units in the left hand column of the
menu. In the window that appears,
activate IPS  (Inch, Pound,

Unit system
QO MKS (meter, kiogram, second)
sen

@13 (inch, pound, second)
O Custom

Type Junit Decimals  [Fractions More
Basic Units

. Material Properties Fenai: ches 1224
Second). You should also increase e .
the Decimal Places to four (4) as | ||Fower = Fommmer
indicated in Figure 1-11. Close the T = ST

Per Linit Valume inches~3 m

“Document Properties” menu with the )

OK button. Now go to File and select SI
Save As. First select the FOLDER - - =

you wish to save this template in, then

title your part as ANSI-INCHES, Figure 1-11. Units Menu

select Save as Type and select Part
Templates (*.prtdot). Then save it in your folder. Repeat the above process, only this time, the
Units you select will be MMGS (Millimeter, Gram, Second). Two decimals should be
sufficient for metric measurements. Save this template also in your FOLDER, but change your
title to ANSI-METRIC and select the Save as Type and select Part Templates (*.prtdot).
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STANDARD TITLE BLOCK DRAWING SHEETS

The next process is to set up a Title Block to reflect the two measurement styles. You may have
to draw a title block (see Figure 1-12) if one has not been provided. An example of a title block,
with suggested dimensions and style, is available in Appendix A. If a Title Block has been
provided, go to File and Open that drawing file. Go to the Tools pull-down menu and select
Options. Under the Document Properties tab make sure that the Dimensioning
Standard is set for ANSI. Next select Units in the left hand column. In the window that
appears, activate IPS (Inch, Pound, Second). Three (3) decimal places will be all you should
use here unless you are doing very high tolerance drawings.

Go to Insert — Annotations — Note to add your personal information, such as NAME, DESK
NUMBER, and SECTION NUMBER. In the Feature Manager Tree, right click on Sheet 1
and select Edit Sheet. Now that this is done, go to File and Save As. First select the
FOLDER you wish to save this template in, then title your part as TITLEBLOCK-INCHES and
select the Save as Type and select Drawing Template (*.drwdot).

Repeat the above process, only this time, the Units you select will be MMGS (Millimeter,
Gram, Second). Two (2) decimals should be sufficient for metric measurements. Add your
personal information such as NAME, DESK NUMBER, and SECTION NUMBER. In the
Feature Manager Tree, right click on Sheet 1 and select Edit Sheet. Save this template in
the same way, but change your title to TITLEBLOCK-METRIC and select the Save as Type
and select Drawing Template (*.drwdot).

INSERTING A PART (RENDERED PICTORIAL) ONTO A TITLE BLOCK SHEET

For each of the assignments you will be asked to submit a printed copy of the part that you built
in SolidWorks. The following will be the procedure to accomplish this requirement.

A. Build the solid model according to instructions and save that part in your folder with the
file extension of .sldprt.

B. Open the appropriate Title Block drawing sheet (see Figure 1-12 for example). The
Title Block drawing sheet that you open should have the same units as the solid part
(metric or inches).

C. Pull down Windows and then select Tile Vertically. This allows you to see all the
windows that you have open at the same time.

D. Select the Part Name in the Feature Manager Tree and while holding down the left
mouse button, drag it onto the Title Block drawing sheet. At this time you have several
options available to choose from. For most of your labs you will be choosing a pictorial
view or current view. In unit nine and ten you will be choosing the three views layout of
the object that you insert onto the Title Block. If you do not see the three views, right
click on Sheet 1 in the Feature Manager Tree and sclect Edit Sheet.
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E. Pick the window around the pictorial view. You get a menu window that lets you adjust
the scale of the image to better fill the sheet.

F. In the drawing area of the Title Block Sheet Insert the title of the object. Provide the
exercise number in the upper right hand box of the Title Block. Your Title should be
placed in an open area of the Title Block and a larger font size, i.e. 0.18 or 0.20. Your
name, desk, Sec and exercise number should be font size 0.125 or 12pt.

Figure 1-12. An Example of a Student
Title Block Sheet
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Exercise 1.1: METAL GASKET

In this first exercise, you will build a metal gasket part. This part is primarily a 2-D object with a
thin depth that will be extruded. The gasket features can be drawn with many of the 2-D
sketching entities and editing features using the sketch toolbars. Go to your folder and Open the
file ANSI-INCHES.prtdot. In order to avoid corrupting the ANSI-INCHES.prtdot template
go to File — Save as: under File Name, type METAL GASKET, and under Save as type,
Select .sldprt and select SAVE.

First set up the sketching grid and —

units. Pull down the Tools menu
and select Options. Under the R |l

Document Properties tab, click ik - ——

the Grid/Snap tab and set the g:::::.f;;ns zz::maucscahng

“Major grid spacing” to 0.25 and Rt Heior ot spacin

“Minor lines per major” to 1. Also | M| B e - '

click on (\) all the “Grid” boxes | ||[EH

and set “Snap points per minor” to b s

1, as shown in Figure 1-13. Click [ [ ||

on the Go To System Snaps and | | |[omee

make sure that the Grid and Snap | e

only when grid is displayed | ||| -ssometrolerance

boxes are checked. Also make sure | | Co i,

the Units are in Inches to 2

decimal places. Then click OK to | Figure 1-13. Setting Grids and Units for the Sketch.
close the menu.

You will design the gasket in the front view, so click on the Front plane in the Feature Manager
tree. The front plane should highlight in green. Next click on the Sketch icon (drawing pencil)
on the upper left side or the screen. The sketching grid will now appear on the screen with grids
spaced every 0.25 inches. Also make sure you are viewing this from the Front View orientation
(see Figure 1-7).

Now study the outline of the gasket shown in Figure 1-14. You will sketch this outline on the
quarter-inch grids using the line tool. Click the Line icon on the sketch menu toolbar. Now
draw five lines according to the specifications in Figure 1-14 and detailed below. All (X,Y)
coordinates are relative to the sketch “origin” seen in the middle of the screen.

The top line starts at (-2.75, 1.25) and ends at (2.75, 1.25).

The right side line starts at (2.75, 1.25) and ends at (2.75, -1.25).

The bottom right diagonal line starts at (2.75, -1.25) and ends at (0.00, -2.75).
The bottom left diagonal line starts at (0.00, -2.75) and ends at (-2.75, -1.25).
The left side line starts at (-2.75, -1.25) and ends at (-2.75, 1.25).

The 2-D outline of the gasket should now be finished and completely enclosed.
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Figure 1-14. The Beginning Outline for the Metal Gasket.

Using the Rectangle sketching tool, draw a rectangular slot 3.00 inches wide by 0.50 inches
high, and completely centered on the origin, as shown in Figure 1-15. Next select the Circle
sketching tool, and create the five circles along the corners of the outline. All circles have the
same diameter of 0.50 inches and are positioned as indicated in Figure 1-15. Note: While you
are sketching the lines, rectangle, or circles, the end of the cursor pencil shows a small icon that
indicates the current type of sketch entity that you are using. This is called a “smart cursor.”

1 @50

Sketch Fllet ?
1.bo v RS
| Fillet Parameters ]

175 A | 0,500

Keep constrained
COFMErs

|= |

~ P Figure 1-16. Sketch Fillet
™. pad Menu.

Figure 1-15. Adding the Five Circular
Features and Rectangular Slot.
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The five corners of the gasket are sharp and need to be rounded. This can easily be accomplished
using the fillet editing command. Click the Fillet icon (round corner symbol) on the sketching
toolbar. Notice that a “Sketch Fillet” menu now appears where the Feature Manger tree usually is
displayed (Figure 1-16). Key in a fillet radius of 0.50 inches. Now, one by one, click on the
two edges of the corners (or merely click on the point of intersection) to create a fillet there.
Once the five fillets are added, click on the green (\/) button on the “Sketch Fillet” menu. The
five fillets are now completed as shown later in Figure 1-18. Now that you know how to add
fillets, add four more Fillets to the inner corners of the rectangular slot. Use a radius of 0.125.

Now you will draw a polygon on the gasket. Pull down Tools, sclect Sketch Entities, and

then select Polygon. The “Polygon” menu appears on the screen where the previous fillet menu

appeared. First draw the polygon on the gasket in

its approximate position. Now study the actual

parameters needed for the polygon and then set them o

as shown in Figure 1-17. [% "ﬁ I == |[$ |
Number of sides = 6 Polygon ?
Inscribed circle dot wh
X-origin = 0.00
Y-origin =-1.00 _
Inscribed circle diameter = 1.00
Rotation angle = 0°

Once the parameters are set, click on the green (V) | |

button on the “Polygon” menu to close the menu and

|:| For construction

complete the polygon, as shown in Figure 1-18. @ & =
The next feature to sketch is a “fan” shaped quarter- () Inscribed circle

circle. First, sketch a horizontal Line from (1.50, {3 Circumscribed circle
-0.50) to (0.75, -0.50). Then draw a vertical Line .
from (0.75, -0.50) to (0.75, -1.25). To add the | | {3 [0.00 =
quarter circle arc, select the Centerpoint Arc @ 00 =
sketching icon. Click the center of the arc to be at the v : )
intersection of the two lines just drawn. Hold the left @ L.on 3
mouse button (LMB) down and drag the cursor down Sl
to the end of the vertical line. Click the LMB at that B 0.00° L=y

point to define one end of the arc. Then hold it down
and drag it to the end of the horizontal line. Once
again, click the LMB at that point to complete the arc.
You should have a drawn arc feature as shown in
Figure 1-18.

| Mew Polygon

Figure 1-17. Polygon Menu.
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Figure 1-18. Sketching the Polygon and Right Side Fan-Shaped Arc.

You now need to finish the gasket by creating a symmetric arc feature on the left side of the
polygon. SolidWorks offers many tools for sketching and editing. One of these tools is the
“Mirror” sketch feature about a centerline. Select the Centerline sketch icon, which is in the
pull down menu of the line command, and draw a centerline vertically from top to bottom, and
through the origin, as shown in Figure 1-18 above. Click the Select (LMB) button. Now hold
down the Control (Ctrl) key and select the following: the centerline, horizontal line of the arc,
vertical line of the arc, and the arc itself. Now click the Mirror (bell-shaped) icon. The fan-
shaped arc feature will now mirror to the left side. The gasket outline is now complete as shown
in Figure 1-19.

/| ™
4 ™
b, v,
f/ \\
N d \ /
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AN \ / d
P =
S P
~_1L

Figure 1-19. The Finished 2-D Sketch of the Gasket.
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EXTRUDING THE GASKET THICKNESS

The gasket can now be extruded to its proper thickness.

Select the Features icon and select Extrude or pull B gl oo _ ]
down the Insert main menu, select Boss/Base, and then EE;SZ“;::E p Menfbesslese. R
Extrude, as shown in Figure 1-20. The “Extrude” menu L) Lof B '

then appears on the screen in the Feature Manager area | | Featises [TSketeh |

(Figure 1-21). Set the parameters for the extrusion: | =] oo

@ Extruded Boss /Base
ﬂ Extrudes a sketch or selected sketch
contours in one of two directions to
ﬁ?a create a solid feature,

Direction One = Blind
Distancel = 0.125 inches

Notice that the extrusion appears as a preview in the )
computer sketching area in an Isometric view. Click on Figure 1-20. Extruding the

() the green button on the “Extrude” menu to finish. Gasket Thickness.

Now you can view your model. On the “View Orientation” window (you should have it push-
pinned onto the screen) click Trimetric. You should see the thin solid model appear as a
trimetric view (see Figure 1-22). Also try Isometric, Dimetric, and Front view orientations.
You can experiment with some of the viewing operations in SolidWorks. Click the Rotate
View icon (it appears as circular arrows on the top toolbars). Now rotate your model into
different configurations. Also try several Zoom commands and the Pan command.

If you would like to change the color of your model, click on the

model name in the Feature manager tree and then select the [@] B ||% 1@
colored ball in the menu bar. You can then assign any color you

wish to the model.

7 R &
You should save your model. Now save your model. Pull down — -
the File menu and select Save As. On the “Save As” menu,
select your appropriate file folder in your account, type in the [Scetch Plane v]
part name METAL GASKET, and the file type as sldprt, then | | [o—err —
click Save. @ (G 3
Before you finish this exercise, you should print a hard copy for V.
submission to your instructor. Check with your instructor first ‘
for any special printing instructions. You may need to use a : =
special sheet like the Title Sheet shown in Figure 1-12. You o4 |D'125'n =
can insert the rendered Metal Gasket image into your Title [EH |
Block drawing sheet that was created in the introduction to this
chapter, as shown in Figure 1-22. To put this object on a Title Recftateard

Sheet, follow the instructions on Page 1-7. e —
Conversely, you can place your name and class data on the [C] ThinFeatwre  ¥|

printed drawing.  Pull down the Insert menu, select
Annotations, then Note. A note box appears at the end of the | SelectedContours ¥ |
cursor and a “Note” menu appears in the Feature Manager area.
Type in your name and class data in the note box. Figure 1-21. Extrude
Menu.
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If you check (V) off the “Use documents Font” in the menu, you can change the font, for example
to:

Font = Arial

Font Style = Regular

Points = 12

Now SAVE your drawing sheet to your directory as METAL GASKET.slddrw. Take note that
the title of the part and the drawing are the same but the extension has changed. The solid model
and the drawing are linked, meaning that any changes made to the solid model will automatically
be updated on the drawing.

Before you print your copy, make sure you have set the File, Page Setup to Landscape
mode. Now pull down the File and Print Preview commands from the top main menu, then the
Print button to send it to the default printer.

O
Q)

O
w,

O

METAL GASKET @

NAME: STUDENT e S EE

ENGINEERING DESIGN GRAPHICS

Figure 1-22. Metal Gasket Model Inserted into the Title Block Drawing Sheet.



Exercise 1.2: COVER PLATE

There are many different approaches to creating a 2-D computer sketch using SolidWorks. The
approach will depend on the design intent and also on the designer’s own preferences and
choices. In the previous Exercise 1.1, geometry was constructed on a frontal plane using X-Y
coordinate geometry and a grid system. In this Exercise 1.2, you will construct the 2-D geometry
on a horizontal (top) plane since this is the normal orientation of the cover plate. Also, instead of
using a grid coordinate system for laying out the design, you will use simple dimensions related
to the geometry and to the computer space origin.

Go to your folder and Open the file ANSI-INCHES.prtdot. In order to avoid corrupting the
ANSI-INCHES.prtdot template go to File — Save as: under File Name, type COVER
PLATE, and under Save as type, Seclect
.sldprt and select SAVE. Click the Top plane
in the “Feature Manager.” Also click Top view

in the Standard View toolbar to see the top plane Modity R
in green on the screen. Now click the Sketch g [0k mig

icon on the upper left toolbar, then click the vix|sj2f>
Circle icon. Draw a large circle that is centered
at the origin. For now, the diameter is
unimportant because you will dimension it. Click
the Dimension icon (slanted dimension line) on
the right toolbar. Pick a point on the
circumference of the circle and drag the
dimension out to the upper right side of the circle. Figure 1-23. Setting the Circle
The dimension is not likely to be correct, as soon Diameter.

as you place the dimension a small Modify box
appears (see Figure 1-23). Key in 10.00 inches
and click the green (V) check box. The diameter
of the circle changes to the new value. If the
circle gets too big, use Zoom to see it better.

Now you will extrude the circle into the solid
base part of the cover plate. Select the Features
icon and select Extrude or pull down Insert,
select Boss/Base, and then Extrude. Set the
parameters for the extrude to be:

Direction One = Blind
Distancel = 0.50 inches Figure 1-24. Base Part
Click the green () button on the “Extrude” menu of the Cover Plate.

to finish. View the cover plate as an Isometric
(Figure 1-24).
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You will now draw the geometry for the indentation part of the cover plate. Click on the top
surface of the Cover Plate model and it should turn cyan. This will be the next sketch
surface. Also select Top on “View Orientation” for better viewing of the sketch plane. Click the
Sketch icon to start the next sketch. Select Circle and draw a circle centered at the origin.
Now draw a second bigger circle centered at the origin, but not as big as the 10.00 inch diameter
of the base plate. Now, using the Dimension icon, set the diameter of the smaller new circle to
4.00 inches and the diameter of the bigger new circle to 8.00 inches.

Using the Line sketching tool, draw two parallel lines across the plate. One line should be
slightly above the origin, and the other should be below. Both should span across the two circles
as shown in Figure 1-25. Next Dimension them so that one line is 0.50 inches above the
origin, and the other is 0.50 inches below the origin. This places the parallel lines 1.00 inch
apart, as indicated in Figure 1-25.

—1.00

Figure 1-25. The Beginning Geometry for the Indentation.

Now you will trim these lines. Now select the Trim icon on the sketch editing toolbar. In the
area where the Feature Manager tree is you will see a Trim — Options box. Select the last
option (Trim to Closest). A scissors icon now appears on the end of the cursor indicating that
you are in the trim mode. Trim the line portions (four places) that extend beyond the big circle
by just clicking on them with the LMB. Next trim the two line pieces inside the small circle.
Finally trim the portions of the circles that cross between the two parallel lines (four places). You
should now have a pattern like in Figure 1-26. Now repeat the above process (Line,
Dimension, Trim) to create identical patterns in the vertical direction. This final pattern for the
indentation is shown in Figure 1-27.
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Figure 1-26. The Initial Pattern after Trimming the Lines and the Circles.

Figure 1-27. The Finished Pattern for the Indentation.



Now you will cut the indentation pattern into the cover
plate. It is advisable to go to an Isometric view
when executing an extrusion of any kind. Select the Q
Features icon and select Extruded Cut or pull

down Insert, select Cut, and then Extrude. The

“Cut Extrude” menu appears in the Feature Manager
area. Key in these parameters:

Direction One = Blind
Distancel = 0.25 inches

Click the green (\/) button to finish. View the cover
plate as a rotated Isometric (Figure 1-28).
Figure 1-28. The Indentation Pattern
Now create the lift hole in the middle of the plate. Cut into the Plate.

Click the cursor on the top center surface of the cover
plate (it should turn cyan). Also, select a ToOp view orientation. You might also need to Zoom
in to see the center portion better. Click the Sketch icon to get into the sketching mode. Since
the lift hole is symmetric about the origin, you can use a mirror function. So start by drawing a
vertical Centerline (CL) through the origin. Draw a small Circle to the right side of the

centerline. Then draw two parallel Lines
that start at the centerline and go through \
part of the circle, as indicated in Figure 1- s
29. Now apply the following inch |
Dimensions to the sketch geometry. | 75
|
|
|

Circle Diameter = 0.75 20—
Lateral Dist. from CL = 0.75
Linel from origin = 0.20 (above) e 0
Line2 from origin = 0.20 (below) e

Circle center = 0.20 (above Line2) o0

N,

Now Trim the two line pieces that
overhang the circle, and then trim the part
of the circle between the two parallel lines.
If you get a warning from SolidWorks
about eliminating associated dimensions
while you are trimming, just ignore it and Figure 1-29. Geometry and Dimensions
answer Yes to proceed with the trim. for the Lift Hole.

L
T
|
|
|
|
|

To mirror the feature to the left side of the centerline, hold down the Control (Ctrl) key and select
the following: the centerline, the top line, the circle, and the bottom line. Then click the Mirror
icon. The feature should mirror to the left and the lift hole sketch is complete. Cut the lift hole
pattern through the cover plate. It is advisable to go to an Isometric view when executing an
extrusion of any kind. Select the Features icon and select Extruded Cut or pull down Insert,
select Cut, and then Extrude. The “Cut Extrude” menu appears in the Feature Manager area.
For Directionl, just select Through All. Click the green (\) button to finish this extrude-cut
operation and view the lift hole in Figure 1-30.
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To finish the cover plate, you need to add
four circles around the perimeter to make
the guide holes. Click the cursor on the top
surface again and Sketch four Circles
around the perimeter of the cover plate.
The circles should be at 90 degrees to each
other. The centers should be on the
perimeter and aligned with the origin. The
diameter of all four circles should be 0.75,
as shown in Figure 1-30.

Now pull down Insert, select Cut, and
then Extrude. The “Cut Extrude” menu
appears in the Feature Manager area. For
Directionl, just select Through All, and
click the green (\/) button to finish the part. Figure 1-30. Sketching the Circles
Now view your model in an Isometric for the Guide Holes.

view, as shown in Figure 1-31.

If you would like to change the color of your model, click on the model name in the Feature
manager tree and then select the colored ball in the menu bar. You can then assign any color you
wish to the model.

You should now save your model. Pull down File, select your file folder, select Save As, type
in the part name COVER PLATE.sldprt, then click Save. Insert the rendered Cover Plate
image into your Title Block

drawing sheet that was
created in the introduction to
Chapter 1 (See Figure 1-31.
Follow the instruction given
on Page 1-7. Now SAVE
your drawing sheet to your
directory as COVER
PLATE.slddrw. Take note
that the title of the part and
the drawing are the same but
the extension has changed.
The solid model and the
drawing are linked, meaning
that any changes made to the
solid model will auto-
matically be updated on the — T il i
drawing. ENGINEERING DESIGN GRAPHICS

COVER PLATE

Figure 1-31. The Finished Cover Plate Part.



Exercise 1.3: WALL BRACKET

The sketch geometry used in Exercises 1.1 and 1.2, like line, circle, rectangle, and arc, are
sufficient for designing many different kinds of parts. Sometimes more advanced 2-D geometry,
like an irregular curve, may be needed to complete a design. In the case of the Wall Bracket for
this Exercise 1.3, you will learn how to use a spline.

Go to your folder and Open the file ANSI-INCHES.prtdot. In order to avoid corrupting the
ANSI-INCHES.prtdot template go to File — Save as: under File Name, type WALL
BRACKET, and under Save as type, Sclect .sldprt and select SAVE. Click the Front plane
in the “Feature Manager.” Also click Front view in the Standard View toolbar to see the front
plane in cyan on the screen. Now click the Sketch icon on the right toolbar. First sketch the
straight line segments of the Wall Bracket outline using the Line tool. Refer to Figure 1-32 for
the proper Dimension for each line segment. Units are in inches and the upper left corner is at
the origin.

8.00 .25
ORIGIN :

257

Figure 1-32. Sketching and Dimensioning the Wall Bracket Lines.

Now you will draw a spline from the bottom of the 4.25 inch line to the bottom of the 1.00 inch
line. Click the Spline sketch icon (it looks like a sine wave). Click the LMB at the first bottom
point. Then with the mouse pressed down, drag the spline over to the first intermediate point
about one third of the way up and about one third of the way to the right. Release the LMB there,
then press it down again and drag the spline to the second intermediate point about two thirds of
the way up and over. Again release the LMB there, then press it down again and drag the spline
to the final point, where you end the spline by double clicking the LMB. Refer to Figure 1-33
for these four points’ positions.

The two intermediate points are used to control the shape of the spline. With the Select cursor,
pick the spline (it should highlight cyan with its four points identified). Now pick intermediate
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point 1 and drag it out and down a little to create a slight bulge. Next pick intermediate point 2
and pull it up a little to create a slight inflection (see Figure 1-34). Note: There are no exact X-
Y coordinates for you to drag these intermediate points to. Just try it a few times until you
achieve a shape that pleases you (for example the shape in Figure 1-34 is acceptable).

- &.00 - 25
s *— 25
1 il T
\\ — 1.00
425 End Point
Intermed. Pt. 2
L
- Intermed. Pt. 1
Start Pt.
Figure 1-33. Sketching the Spline through its Four Points.
- &.00 h 25
25
| |
1 T I
L 1.00

Drag Intermed. Pt. 2

Figure 1-34. Dragging the Intermediate Points to Shape the Spline.
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Now you will complete the left end of the Wall
Bracket by adding the wall hooks. On the left
edge, add the two wall hooks using the Line 50
tool and the Dimension values given in

Figure 1-35. You will have to Trim two i
places on the left edge to make the wall hooks 50 &
contiguous with the rest of the profile. Note: T
The bottom wall hook has the same dimensions 75
as the top one.

— .50

You will finish the Wall Bracket by adding a 425
fillet to the sharp bottom corner on the right
end. Since it was earlier associated with the
1.00 inch dimension, SolidWorks will give you \_r

a warning if you try to fillet it. So it is best to
just first Delete that dimension. Now click the
Fillet sketch icon. Key in a radius of 0.25
inches (refer back to Figure 1-16). Next pick -
the vertical 1.00 inch right edge of the bracket
and pick the spline close to its end point, and
then click the green (V) check to execute the
fillet command. The 2-D profile is now
complete and ready to be extruded. Pull down
Insert, Boss/Base, and Extrude. Key in a Blind distance of 0.125 and click the green (V)
check to complete the Wall Bracket, as shown in Figure 1-36 in a Trimetric view.

Figure 1-35. The Dimensions Used to
Create the Wall Hooks on the Left Side.

If you would like to change the
color of your model, click on the
model name in the Feature WALL BRACKET
manager tree and then select the
colored ball in the menu bar. You
can then assign any color you wish
to the model.

Now Save the part as WALL E
BRACKET.sldprt.  Insert the
Wall Bracket onto a Title Block TTTe—
drawing sheet. Save as WALL
BRACKET.slddrw and Print a
hard copy for your instructor. See

) . . [eme STUDENT DESK. SEC [ EE
Page 1-7 for instructions. [ ENGINEERING DESIGN GRAPHICS

Figure 1-36. The Completed Wall Bracket
in a Trimetric View.
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Exercise 1.4: MACHINE HANDLE

In the previous exercises, the parts were designed using English units (inches). Metric, or System
International (SI), units are also common in engineering practice. In this exercise 1.4, the
Machine Handle will be designed using millimeters as the basic units (see Figure 1-37). In
addition, because of the round symmetry of the machine handle, you will create a Base
Revolve using the 2-D sketch rather than a base extrude.

Go to your folder and Open the file ANSI-METRIC.prtdot. In order to avoid corrupting the
ANSI-METRIC.prtdot template go to File — Save as: under File Name, type MACHINE
HANDLE, and under Save as type, Sclect .sldprt and select SAVE.

Next, Go to TOOLS — OPTIONS — DOCUMENT PROPERTIES and select “Grid/Snap.”
Make the following settings on this menu:

“Major grid spacing” =5 mm

“Minor lines per major” =0

“Check the Display Grid box ().

Also go to System Snaps and make sure “Grid” and the “Snap” functions are checked (V) on, then
click the OK button.

Pick a Front plane and click the Sketch icon to start your sketch. The screen area should show
a metric grid with spacing every 5 millimeters. You may need to Zoom in. Using the
Centerline, Line, and Centerpoint Arc tools, sketch the enclosed 2-D profile shown in
Figure 1-37.

Origi Centefling

Figure 1-37. The 2-D Sketch for the Machine Handle.
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Now you will revolve this simple sketch into a solid
model. Go to the Features option and Select the
Revolve Base/Boss icon. The “Base Revolve”
menu appears in the Feature Manager area as
shown in Figure 1-38. The main choice you have
here is the degrees of revolution about the
centerline. Set it to a full revolution of 360° and
then click the green (\) check to close it. Your part
should now appear as shown in Figure 1-39 with
an Isometric view.

There are many different designs for a Machine
Handle, and the one here is quite typical. After
studying it, however, you notice that the sharp outer
edge on the right side poses a concern. SolidWorks
allows you to easily fix these design changes after
the solid model has been built. One way is to
simply go back and edit the original sketch.

Notice in the Feature Manager that SolidWorks
keeps a running tabulation of the features you used
to build the part. One of them should read “Base
Revolve,” which is the operation you just
completed. Left of this “Base Revolve” is a plus
(+) sign. Click on this (+) sign and down comes the
name of “Sketchl.” Right mouse click on this
Sketchl label and a short pull-down menu appears
as shown in Figure 1-40. Left mouse click on the
Edit Sketch option and the sketch appears again,
with grids, on the screen. Select the Front view
orientation to better see the sketch.

There are different ways to eliminate the sharp
edge. One way is to use a chamfer; however you
probably cannot find a chamfer icon on the sketch
editing toolbars. The chamfer icon is nested with
the fillet icon. An down arrow next to the fillet icon
is another pull down menu and under that menu is
the Chamfer icon. The “Sketch Chamfer” menu
now appears. Set the “Chamfer parameters” as
shown in Figure 1-41, including the chamfer
distance of 3 mm. Now click on the two lines that
form the sharp edge corner, and then click the green
(V) check to complete this chamfer operation.
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Figure 1-38. Revolve Menu.

Figure 1-39. The Part after the

Sketch is Revolved.
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The new feature is created, but the new model is not displayed yet. You need to rebuild the
model first. Pull down Edit, and select the Rebuild option (it may be in the customize menu
section of the pull-down menu). Note: There is also a small icon for the rebuild command. It
appears on the top toolbar and looks like a green and red traffic light. The model is rebuilt now
with a chamfer, as shown in the final picture (Figure 1-42) in an Isometric view with the
Shadows in Shaded icon clicked on. Now you see how easy it is to make design changes to a
solid model that is already built. You just simply edit the sketch that created the model in the
first place.

Sketch Chamfer
o R &
T —

() angle-distance
{+) Distance-distance

Equal distance

ot [ 3.0000mm = "

Figure 1-42. The Machine Handle in
an Isometric View with a Shadow.

Figure 1-41. The Sketch Chamfer Menu.

If you would like to change the color of your model, click on the model name in the Feature
manager tree and then select the colored ball in the menu bar. You can then assign any color you
wish to the model.

Printie | e Page || FreviPae | s Rea | | Zoomin | s | | Cios

You should now save your model.
Pull down File, select Save As,
type in the part name MACHINE
HANDLE.sldprt, and then click
Save. Insert the rendered
Machine Handle image into your
Title Block drawing sheet, as
shown in Figure 1-43. Add the
title of the part in the open area of
the drawing with a 20pt or 6mm
letter height. Also add the
Exercise number (4.1) in the
upper right hand box of the Title
Sheet. Now SAVE your drawing
sheet to your directory as
MACHINE HANDLE.slddrw.

MACHINE HANDLE

| name: STUDENT pesk 01 sec: 01 ‘ s ‘
| ENGINEERING DESIGN GRAPHICS

L7940 [nder Defined. | Edting Craming Vew?

il

Figure 1-43. A Print Preview of the Machine Handle
on the Title Block Drawing Sheet.
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Supplementary Exercise 1-5: SLOTTED BASE

Make a full size sketch of the figure below in the Top Plane and extrude it for 0.50 inches.
Insert it on a Title Block and title it “SLOTTED BASE.”

ASSUME THE GRID DIVISIONS TO BE 0.25 INCHES

Supplementary Exercise 1-6: TRANSITION LINK

Make a full size sketch of the figure below in the Front Plane. Extrude it 0.375". Insert it onto
a Title Block and title it TRANSITION LINK.

ASSUME THE GRID DIVISIONS TO BE 0.25 INCHES
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Supplementary Exercise 1-7: TEE BRACKET

Make a full size sketch of the figure below in the Top Plane and extrude it to the height
indicated. Insert it on a Title Block and title it “TEE BRACKET.”

TEE
BRACKET

=

\

ASSUME THE GRID DIVISIONS TO BE 5 MM

PICTORIAL OF THE TEE
BRACKET

Supplementary Exercise 1-8: CABLE SPOOL

Make a full size sketch of the PROFILE below in the Front Plane and do an INSERT -
BASE — REVOLVE. Insert it on a Title Block and title it “CABLE SPOOL.”

s CABLE
&N
- PROFILE
| 1 1 | ]
N |
R _
| N | '

=
P

ASSUME THE GRID DIVISIONS TO BE 1.00 INCH
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